


Curriculum Plan of Mathematics STD VIII (Session: 2026-27)

Book prescribed: NCERT Mathematics

Month Project/Activity Mental Maths / Written Work
Content/Theme Value based

questions
April > Evolution of number system (Natural > Worksheet > Key Terms

Chapter 1 (Rational Numbers)
> Rational numbers

> Properties of rational numbers
> Roles of zero and one
> Negative of a rational number
> Multiplicative inverse

> Representation of rational numbers on number line.

> Rational numbers between two rational numbers

Chapter 2 (Linear equations in one variable)
> Solving equations having variable on one side
> Application of linear equations
> Solving equations having variable on both side
> Reducing equation to simpler form
> Equations reducible to the linear form

numbers, Whole numbers, Integers) which
lead us to the collection of Rational
numbers.

> Solving a linear equation in one
variable — balancing method

> Quiz cum Sport activity on linear
equation and its application

> Discussion on
Real life
applications of
Rational
number.

>  Worksheet

> Formation of
equation based
of real life
application of
linear equation

> Value based
questions.

> NCERT
Textbook
Exercise

> Assignment

> R.D Sharma
Reference book

> Key Terms

> NCERT
Textbook
Exercise

> Assignment

> R.D Sharma
Reference book




Month Project/Activity Mental Maths / | Written Work

Content/Theme Value based
questions

June = Convex and concave polygon > Worksheet > Key Terms
Chapter 3 (Understanding Quadrilaterals) = Angles in a polygon > Relating > NCERT

> Polygons = Exterior angles of a polygon different > Textbook

> Classification of polygons = Properties of the diagonals' of a thombus shapes that are Exercise

> Diagonals = How to ch'ange one Q'uadrlla.te.ral to another . used in > Assignment

> Convex and Concave Polygons l;?%e:; ioldlng and cutting activity to understand properties everyday life. | R.D Sharma

> Regular and irregular polygons Reference book

. = Making a list for quadrilaterals
> Interior Angle sum property for polygons| ([ ab Activity

> Sum of measure of exterior angle of a To prove angle sum property of a quadrilateral
polygon Lab Activity
> Types of quadrilaterals = To prove exterior angle property of any polygon.

> Some special parallelograms




July

Chapter 4 (Practical Geometry)
> Construction of quadrilaterals

> Some special cases of quadrilateral

Chapter 5 (Data Handling)

> Organizing data

> Grouping data

> Circle graph or Pie-chart
> Chance and Probability

Chapter 6 (Squares and Square Roots)

> Properties of square numbers
> Patterns

> Finding the square of a number
> Pythagorean triplet

> Finding square roots by

o prime factorization
o division method
> Square roots of decimal
> Estimating square root

[JConstructing a Quadrilateral:

e when four sides and one diagonal are given.

e when three sides and two diagonal are given.

e when two adjacent sides and three angles are
given.

e when three sides and two included angles are
given.

e when other special properties are known.

= Introduction to graphs
= Reading a bar graph
= Pie chart
= Introduction to probability
[JLab Activity
= Collect the data and prepare a bar graph, histogram and
pie chart of the data collected

[JLab Activity
= To verify identity (a + b)? and (a-b)? through activity.

Worksheet
Exploring
geometrical
shapes and
understanding
hidden
structures with
real life
examples.

quiz on
probability

> Topic wise

Worksheet

> C(lass test

NCERT
Textbook
Exercise
Assignme

nt

Assignment
R.D Sharma
Reference book

KeyTerms
NCERT
Textbook
Exercise
Assignme

nt

R.D Sharma
Reference book

KeyTerms
NCERT
Textbook
Exercise
Assignment
R.D Sharma
Reference book




Month Project/Activity Mental Maths Written Work

Content/Theme

August > Worksheet > Key Terms

Chapter 7 (Cubes and Cube Roots) = Oral test on estimating the cube > NCERT Textbook
> Cubes roots. Exercise

> Cube Roots

Chapter 8 (Comparing Quantities)

> Compound Interest
> Rate compounded annually or half yearly
> Applications of Compound Interest

= To collect the rate of interest of
various banks on different types of
accounts

>  Worksheet

> Discussion on
taxes levied
on different
objects.

> Assignment
> R.D Sharma
Reference book

> Key Terms

> NCERT Textbook
Exercise

> Assignment

> R.D Sharma
Reference book

September
Chapter 8 (Comparing Quantities)
> Increase or decrease percent

> Discounts
> Profit and Loss
> Sales Tax/VAT/ GST

Chapter 12 (Exponents and Power)
> Powers with negative exponents

> Laws of exponents

> Use of exponents to express small numbers in
standard form

HALF YEARLY EXAMINATION

1, 2,3,4,5,6,7,8 - half)

e To collect GST rates on any 10
products.

Activity on:

e Making a list of very small and
very large numbers from the facts
available and convert them in
Standard form. ( Microorganisms
and Planets)

>  Worksheet

>  Worksheet
Class test

> Key Terms

> NCERT Textbook
Exercise

> Assignment

> R.D Sharma
Reference book

> Key Terms

> NCERT
Textbook
Exercise

> Assignment

> R.D Sharma
Reference book




Month
Content/Theme

Project/Activity

Mental Maths

Written Work

October > NCERT Textbook Exercise
Chapter 15 (Introduction to Graphs) o > Assignment

> Linear graphs > Lab Activity > R.D Sharma Reference book

> Applications of graphs = Drawa Iu}e gr.aph of

any real situation
problem.

Chapter 9 (Algebraic Expressions and Identities)

> Expressions Presentation on : > Worksheet

> Terms, factors and coefficient - (a+by > Rey Temns

SIS, 1actors and coctiicients . 2P > NCERT Textbook Exercise
> Monomials, binomials and polynomials. > Assi
) ) ssignment

> lee. e?nd unlike terms‘ . ) > R.D Sharma Reference book

> Addition and subtraction of Algebraic Expressions

> Multiplication of Algebraic expressions

> Multiplying a monomial by a monomial

> Multiplying a monomial by a polynomial

> Multiplying a polynomial by a polynomial

> Standard Identities

Month Project/Activity Mental Maths Written Work

Content/Theme




ovember
Chapter 11(Mensuration)
> Area of trapezium
> Area of general quadrilateral
> Area of a polygon
> Solid shapes
> Surface area of cube, cuboids and cylinders
> Volume of cube, cuboids and cylinder
> Volume and Capacity

> Activity on:

Surface area of Rectangular solids
Application of Mensuration -Cylinder
To verify the formula for volume and
surface area of cylinder, cube
cuboids through activity.

To verify the formula for surface area
of Trapezium through activity

>  Worksheet
Discussion on
various solid
shapes in the
surrounding
and counting
the number of
faces.

Key Terms
NCERT Textbook
Exercise
Assignment

R.D Sharma
Reference book

December

Chapter 13 (Direct and Inverse Proportion)
> Direct Proportion
> Inverse Proportion

Chapter 14 (Factorisation)
> Factorisation by common factors
> Factorisation by regrouping terms
> Factorisation using identities.
> Division of polynomials

PERIODIC TEST -2

(8-half,9,12,15)

>  Worksheet

> Recognizing
direct and
inverse
proportion
based on real
life examples.

>  Worksheet

Key Terms
NCERT Textbook
Exercise
Assignment

Key Terms
NCERT Textbook
Exercise
Assignment




Month Project/Activity Mental Maths Written Work
Content/T

heme

January > To identify factors of a number from a

Chapter 14 (Factorisation)
> Factorisation using identities.

> Division of polynomials

Chapter 16 (Playing with Numbers)
> Letters for digits

> Tests of divisibility

Chapter 10 (Visualizing Solid Shape)
> Views of 3 D shapes
> Mapping space around us
> Faces, Edges and Vertices
> Euler’s Formula

collection of numbers.

> Activity based on :

= Visualizing solid shapes

= Introduction to a prism

= Introduction to a pyramid

= To make the nets of 3Dshapes.

= To draw a map of the route from house to

school showing different landmarks.

>  Worksheet

>  Worksheet

>  Worksheet

> Observation of
different things in the
surrounding and
discussing their various
views.

> Key Terms
> NCERT Textbook
Exercise

> Assignment

> R.D Sharma
Reference book

> Key Terms

> NCERT Textbook
Exercise
> Assignment

> Key Terms

> NCERT Textbook
Exercise

> Assignment

R.D Sharma
Reference book

v

February

REVISION FOR ANNUAL EXAMINATION

March

ANNUAL EXAMINATION




Curriculum Plan of Science (Session: 2026-27)

Book prescribed: NCERT

Science

Month Project/Activity Oral Work Written Work
Content/Theme
April )
Chapter 8 (Cell Structure and Functions) > . Video > Oral

> Discovery of thecell e Cell structure and function Questioni > Keyterms'

> The cell e Difference between plant cell and ng > KeyQuestions

> Organisms show variety in cell number, animalcell > NCERT > NCERTexercise

shape and size > Activity Exemplar > ScienceExemplar

> Cell structure and function . Temporary/Permane Discussion > Assignments

> Parts of thecell nt slidesof > Diagrams ofOnion peel cells,

> Comparison of plant and animalcells [CTOOIEAMSIS . cheek cells, animal vs.

e Temporary slide of onion/human plantcell
cheekceells

Chapter 4 (Materials: Metals and Non- > Video > Keyterms
Metals) e Physical properties of Metal > Oral > KeyQuestions

> Physical properties of metals and non- metals andNonmetals. Question ~ NCERT _

> Chemical properties of metals and non- e Displacementreactions ing e, E);Z;cllslz r

metals > Activity > NCERT - t p
> Uses of metals andnon-metals e To check the electrical Exempl ssighments
conductivityof Materials ar
e Burning of Sulphurpowder Dlscuss
ion

e Reaction of metals and nonmetals
withacids




Chapter 11 (Force and Pressure) > Video > Oral > Keyterms
> Force-a push or apull e Forces are due to Question > KeyQuestions
> TForces are due to aninteraction interaction ing > NCERTexercise
> Exploringforces e Contact and Non-contact forces > NCERT ScienceExemplar
> A force can change the state ofmotion Exempl
ar
Discuss
ion
Month Project/Activity Oral Work Written Work
Content/Theme
June PERIODIC TEST -1

Chapter 9 (Reproduction in Animals)
> Modes of reproduction
> Sexual reproduction
> Asexual reproduction

Chapter 10 (Reaching the age of

Adolescence)

(Subject Enrichment-seminar)
> Adolescence and puberty

> Changes atpuberty

> Video
e Male/Female reproductive system
e Binary fission
e Budding
e Metamorphosis
> Activity
e To observe the slide of Binary fission inAmoeba

> Video
e Endocrine glands hormone and function
e Sex determination in the unborn baby
> Activity
e Calculation of fullheight

> Oral
Questioning

> NCERT
Exemplar
Discussion

> Oral
Questioning

> NCERT
Exemplar
Discussion

YV VVVY VY

VV VYV VY

Keyterms
KeyQuestions
NCERTexercise
ScienceExemplar
Assignments

Diagrams of
Male/Female
reproductive system,
human sperm, ovum,
fertilization, binary
fission in amoeba,
budding inHydra

Keyterms
KeyQuestions
NCERTexercise
ScienceExemplar

Assignments
Diagrams of sex




v

Y V VYV

Secondary sexualcharacters

Role of hormones in
initiatingreproductive function
Reproductive phase of life inhumans
How is the sex of the babydetermined?
Hormones other than sexhormones
Role of hormones in completing the
lifehistory of insects andfrogs
Reproductive health

Chapter 12 (Friction)

>

Force of friction

> Factors affectingfriction

Y V VY

Friction: a necessaryevil
Increasing and reducingfriction
Wheels reducefriction
Fluidfriction

Chapter 5 (Coal and Petroleum)

>

>
>
>

Coal

Petroleum

Naturalgas

Some natural resources arelimited

o Collect newspapercuttings and information
from magazines aboutHIV
o /AIDS.

> Video
o Friction: A necessaryEvil
e FluidFriction

> Activity

'Wheel reducesfriction

> Video
e Exhaustible and inexhaustible naturalresources
e Refining ofpetroleum
> Activity
e Get an outline map of India. Mark the places in
the map where coal, petroleum and natural gas
arefound.

Oral
Questioning
NCERT
Exemplar
Discussion

Oral
Questioning
NCERT
Exemplar
Discussion

Y V VY

determination of
unborn child, position
of endocrine glands in
the humanbody

Keyterms
KeyQuestions
NCERTexercise
ScienceExemplar

Assignments

VYV VY VY

Keyterms
KeyQuestions
NCERTexercise
ScienceExemplar
Assignments

Diagram of Refiningof
Petroleum




July & August

Chapter 2 (Micro-Organisms Friend and
Foe)
> Microorganisms

Where do microorganismslive?
Microorganisms andus
Harmfulmicroorganisms

Foodpreservation
Nitrogenfixation
Nitrogencycle

YVVVVYVYY

Chapter
16(Light)
> What makes thingsvisible
Laws oftreflection
Regular and diffusedreflection
Reflected light can be reflectedagain
Multipleimages
Sunlight: white orcoloured
What is inside oureyes?
Care of theeyes
Visually challenged persons can
read and write
> What is the braillesystem?
Chapter 6 (Combustion and Flame)
>  What isfuel?

> Fuelefficiency

YV VY YVYYVYYVY

> Video
e Microorganisms Friend andFoe
e Nitrogen cycle

> Activity
e Observation of pond water for presence
ofmicroorganism.

e Hands on activity todemonstrate
fermentation of Sugar solution and Dough
by usingyeast.

e To show temporary/permanent slides of
variousmicroorganisms.

> Video
e Reflection ofLight
e HumanEye
e Care of eyes
> Activity
e Multiple reflection usingmirror
e Kaleidoscope construction andworking

> Activity
e Experiment to show that air is essentialfor
burning
e Make a model of fire extinguisher

> Oral
Questioning
> NCERT

Exemplar
Discussion

> Oral
Questioning

> NCERT
Exemplar
Discussion

> NCERT
Exemplar
Discussion

VYV VY

YV VVVYY

Keyterms
KeyQuestions
NCERTexercise
ScienceExemplar
Assignments
Diagrams
ofMicroorganisms,
Nitrogencycle

Keyterms
KeyQuestions
NCERTexercise
ScienceExemplar
Assignments
Diagrams of Laws of
Reflection, HumanEye

Assignments
Diagram of different
zones of candle flame




Month Project/Activity Oral Work Written Work
Content/Theme
August & September e Electroplating > Oral > Keyterms
Chapter 14 (Chemical effects of electric o Testing conduction of electricityin Questioning > KeyQuestions
current) lemon juice orvinegar > NCERT > NCERTexercise
> Do liquids conductelectricity? e A simple circuit showingelectroplating Exemplar ScienceExemplar
> Chemical effects of electriccurrent Discussion > Assignments
> Electroplating > Diagram
ofElectroplating
Chapter 13 (Sound)
> Sound is produced by a vibratingbody > Video > Oral > Keyterms
> Sound produced byhumans e HumanEar Questionin > KeyQuestions
> Sound needs a medium forpropagation e Sound Needs a Medium for g > NCERTexercise
> We hear sound through our ears Propagation > NCERT > ScienceExemplar
> Amplitude, time period and frequency of |~ Activity Exemplar > Assignments
avibration * Jaltrang . . Discussion > Diagrams ofvoice
> Audible and inaudiblesounds e Sounds Needs a Medium for propagation box, HumanEar
> Noise and music

> Noise pollution




Month
Content/Theme

Project/Activity

Oral Work

Written Work

October & November

Chapter 1 (Crop Production and Management)

>

YV VY VYV VY

Chapter 3 (Synthetic fibre and Plastics)

>

VY VYV

Agriculturalpractices

Basic practices of crop production
Preparation ofsoil

Sowing

Adding manure andfertilizer
Irrigation

Protection fromweeds
Harvesting,Storage

Food from animals

What are syntheticfibres?

Types of syntheticfibres
Characteristics of syntheticfibres
Plastics

Plastics as materials ofchoice
Plastics and theenvironment

HALF YEARLY EXAMINATION

> Video

Kharif and Rabicrops
Methods of irrigation

> Activity

Collect new agricultural
machine pictures and
paste them in your
notebook with their
names and uses.

Hands on activity to
demonstrate Selection
ofSeeds

> Video
o Synthetic fibres and uses.
> Activity
> Debate on the topic ‘My
fabric isSuperior’

> Oral
Questioning

> NCERT
Exemplar
Discussion

> Oral
Question
ing

> NCERT
Exemplar
Discussion

>
>

Y V.V YV

VYV VY VY

Keyterms
KeyQuestions

NCERTexercise
ScienceExemplar
Assignments

Diagrams of Modern and
traditional methods of
irrigation

Keyterms
KeyQuestions
NCERT exercise
ScienceExemplar
Assignments

Diagrams ofMonomers
andPolymers




Month Project/Activity Oral Work Written Work
Content/Theme
December > Video > Oral > Keyterms
Chapter 15 (Some Natural Phenomenon) ° Charging byRubbing Questioning > KeyQuestions

> Lightning e The Story ofLightning > NCERT > NCERTexercise

> Charging byrubbing e Earthquake Exemplar > ScienceExemplar
> Types of charges and their > Activity Discussion > Assignments

interaction, Transfer ofcharge e Types of Charges and theirInteraction > Diagrams of Electroscope,

> The story oflightning e Working ofelectroscope Lightning conductors,
> Lightningsafety Structure of the

> Earthquakes Earth,Seismograph
January > Video > Oral > Keyterms
(Subject Enrichment) e Deforestation and itsCauses Questionin > KeyQuestions
Speaking Skill o Flora andFauna g > NCERTexercise
Chapter 7 (Conservation of Plants > Activity > NCERT > ScienceExemplar
and Animals) . . e Tree plantation and itsmaintenance Exemplar > Assignments

> Deforestation and itscauses Discussio .

> Consequences ofdeforestation n > Diagrams of .

> Conservation of forest and wildlife Endangeredspecies.
> Biosphere reserve

> Flora and fauna

> Endemic species

> Wildlife sanctuary

> Nationalpark

> Red databook

> Migration

> Recycling ofpaper

> Reforestation




Chapteri18PollutionofAirandWater

>
>
>
>

>
>
>

Airpollution
Howdoesairgetpolluted?
Casestudy-TheTajMahal

GreenhouseEffect,whatcanbe
done?

Waterpollution
Howdoeswatergetpolluted?

Whatispotablewaterandhowis
waterpurified?

> Video
e Airpollution
e WaterPollution
e Green HouseEffect
> Activity
Comparisonofdifferentsampleof
water(smell,acidity,andcolor)

> Oral
Questionin
g

> NCERT
Exemplar
Discussio
n

Y VYV

Keyterms
KeyQuestions
NCERTexercise

ScienceExemplar
Assignments

> What can be done?
February REVISION FOR ANNUAL EXAMINATION
March ANNUAL EXAMINATION




Prescribed books- Honey Dew

Curriculum Plan of English

(Session: 2026-27)

e Poem-Geography lesson

Tenses

o Inter-disciplinary
Linkage
o Preparednes
s during a
calamity
e Core Life skills
o Inter personal
relationship
e Core Values Concern
Self
confidence,
Humility and
Politeness

Month Vocabulary/ Grammar Listening Skills Speaking Skills / Reading Skills | Writing
Content/Theme Art Integration Skills
1 April Verbs Gerunds and participles- | = Dictation = Presenting a story |= Reading for |= Notice
e Thebest Christmas presentin = Giving directions appreciation writing
the world = Listening Text *Enactment of (poem) = Diary
e The Tsunami- ( only for speaking The best Christmas | . Reading for
skills) Subject-verb agreement-3pds present in the world detail

I May

PERIODIC TEST —

1




Month Vocabulary/ Grammar | Listening Skills | Speaking Skills / Reading Skills | Writing
Content/Theme Art Integration Skills
% June Tenses ( Past and future)— | = Dictation = Debate/ Role = Wave = Message
*BipinChaudhary’s = Audio clip: Enactment reading of
lapse of memory ‘The Tiger’ by |e Inter-disciplinary thepoem
and the poem- Last _ o WilliamBlake | Linkage - Reading for
argain Active Passive Voice Human psychology detail
e Core Life skills
o Inter personal
relationship
e Core Values Concern
Selflessness
Politeness
4 July = Articles and = Dictation = PoemRecitation = Reading for |= Article
*The Summit within Determiners =ListeningText |= Class Discussion appreciation writing
of the book they (poem)
read = Reading for
e Inter-disciplinary detail
*And and the Cricket Linkage
o Scientific
significance of
mountains

e Core Life skills
o Inter personal
relationship

e Core Values Concern
Self confidence,
helpful nature
,hard work and
perseverance




Month Vocabulary/ Grammar Listening Skills Speaking Skills / Reading Skills | Writing
Content/Theme Art Integration Skills
1 August Sentences and phrases = Dictation = Talk Time- = Poem = Letter
*This is Jody’s Fawn = Listening text: Sharing personal recitation writing- to
*The duck and the kangaroo. [Nouns and pronouns Laughter theBest experience = Reading for the editor’
Medicine e Inter-disciplinary detail placing an
Modals = Audio clip: Linkage order and
How laughing o Scientific complaint
affects our health significance of letter
Animals

e Core Life skills
o Inter dependence
e Core Values
Concern
Friendship,
moral
obligation

{ September
Recap of all the chapters

HALF YEARLY EXAMINATION

K2

< Book 3:Grammar
Adjectives and Degrees of
comparision

Adverbs and degrees of
comparison -

= Dictation

= ListeningText

= Talking about
Interests and
Hobbies

= Revision of
Novel they
read

= Dramatised
Reading

(Play)

= Revision of
letter




Month
Content/Theme

Vocabulary/ Grammar

Listening Skills

Speaking Skills /
Art Integration

Reading Skills

Writing
Skills

4 October
When I set out ford Lyonnesse

conjunctions

Prepositions

= Dictation

= Audio clip:
Commonly
Mispronounced
Words

= Group-Discussion/
Conducting an
Interview or
CelebrityInterview
e Inter-disciplinary
Linkage
o Scientific
significance of
myths
e Core Life skills
o Inter personal
relationship
e Core Values Concern
Self confidence,
Humility and
Politeness

= Reading for
appreciation
(poem)

= Reading for
detail

*Descriptive
paragraph

1 November
Glimpses of the past

< Book 3: CornerStone
(Grammar)
= Direct and
IndirectSpeech

= A/V-clip:
Biography of
Stephen
Hawking

= Speech
= Discussion
of the book
they read
o Inter-disciplinary
Linkage
o significance of
places and history

= Extended
Reading

Extra
writing
practice




Month
Content/Theme

Vocabulary/ Grammar

Listening Skills

Speaking Skills /
Art Integration

Reading
Skills

Writing
Skills

{ December
A visit to cambridge

PERIODIC TEST -2

= Direct and
IndirectSpeech

= Dictation

= Talk time- Your
Dream City /
Conversation —
offering
condolences
e Inter-disciplinary
Linkage
e Scientific significance
of disabilities
e Core Life skills
o Inter personal
relationship
e Core Values Concern
Self confidence,
courage,determination

= Reading for
detail

= Story writing

1 January
A Short Mansoon Diary

The Great stone face-part 1&2

« Book 3:Grammar

= Dictation

= Audio —clip:
British and
American
Spellings

= ListeningText

= Roleplay
= Discussion ofNovel
o Lesson 6
e Inter-disciplinary
Linkage
o Scientific
significance of
weather
e Core Values Concern
Self confidence,
hope and faith

= Dramatised
reading

(play)

= Picture
Composition

= Newspaper
Report

{February

REVISION FOR ANNUAL EXAMINATION




{March

ANNUAL EXAMINATION
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Books Prescribed: 1. Our Pasts—III

(Session: 2026-27)

2. Social and Political Life— III

Curriculum Plan of Social Science

3. Resources andDevelopment

Month Project/ Activity Oral Work Written Work
Content/Theme
April > Activity > Oral questioning > Key terms
{4 Our Pasts-I11 = Interview of Family member > Discussion-How > Key questions
= Chapter 1 - How When & Where (by students) agriculture changed > Flow Chart-Periodization
1. How important are Dates? after Independence? > NCERT Exercise
2. How do We Know? > Assi ¢
gnmen
> Worksheet
4 Social and PoliticalLife-IIT > Video > Oral questioning
= Chapter 1 - The IndianConstitution = Making of Constitution > Discussion-Minority > Key terms
1. Why Does a Country needa = Key Features of Constitution groups in India > Key questions
Constitution? > Activity > Flow Chart-Features of
2. The Indian Constitution: - Reading the Preamble Constitution
Key features > NCERT Exercise
> Assignment
> India-Political Map
= Chapter 2 UnderstandingSecularism > Video > Oral questioning
1. What isSecularism? = Secularism > Discussion-Schools > Key terms
2. Why is it Important toSeparate > Activity should not promote | > Key questions

Religion from the State?
3. What is IndianSecularism?

= Compare-Annual calendar of
the school with a Normal
calendar

any religion

> NCERT Exercise
> Assignment




Month Project/ Activity Oral Work Written Work
Content/Theme
April > Video > QOral questioning > Key terms
{ Resources andDevelopment = Resource > Discussion on Conserving | > Key questions
= Chapter 1Resources = Types of Resources. resources > NCERTExercise
1. Types of Resources > Assignment
2. Conserving Resources > Flow Chart- Types
of Resources
= Chapter 2 Land, Soil, WaterNatural
Vegetation and WildlifeResources > Video > Oral questioning > Key terms
1. Land, Land Use = Water Scarcity and > Discussion- Forestfire. > Key questions
2. Conservation of Land Resource conservation methods > NCERT Exercise
3. Soil,Factors of soil Formation > Activity > Assignment
4. Degradation of Soil = Collect information-
and Conservation Land use pattern
Measures
5. Water, Problem of water availability
6. Conservation of Water Resources
7. Natural Vegetation and Wildlife
8. Distribution & conservation of
Natural Vegetation andWildlife
June PERIODIC TEST - 1
4 Social and Political Life-ITI > Video > Oralquestioning > Keyterms
- Chapter 3 Why Do We Need = Role ofParliament > Discussion-MPs inyour > Keyquestions
Parliament > Activity state. > NCERTExercise
1. Why should PeopleDecide? = Know more about > Assignment
2. People and theirRepresentatives your state-
3. TheRoleoftheParliament p arligrnentqry
4. constituencies

Who are thePeople in Parliament




Month Project/ Activity Oral Work Written Work
Content/Theme
July > Video > Oral questioning > Keyterms
1 Our Pasts-IIT = Tipu Sultan and East India > Discussion-Battle > Keyquestions
= Chapter 2 From Trade toTerritory Company of Plassey > NCERTExercise
1. East India Company ComesEast. > Activity > Assignment

2. Company RuleExpands
3. Setting up a NewAdministration

= Chapter 3 Ruling the Country side
1. The Company Becomes the Diwan
2. Crops for Europe
3. The “Blue Rebellion” and After

{ Social and PoliticalLife-III
= Chapter 4 UnderstandingLaws
1. Do Laws Apply toAll?
2. How Do New Laws Come About?
3. Unpopular and ControversialLaws

{ Resources and Development
= Chapter 3 Minerals and Power Resources
1. Types of Minerals
Distribution of Minerals
Distribution in India
Power Resources
Non-conventional Sources of Energy.

SR

= Collection of pictures and
stories- Rulers of Princelystates

> Video
= Indigo planters
> Activity
= Report- Rural areas in company
rule

> Video

= Feminist movements in India
> Activity

= Essay- Feminist movement

> Video
= Conventional & Non-
conventional resources
> Activity
= Poster making — Energy
conservation measures

> Oral questioning

> Discussion-Life of
the workers

> Oral questioning

> Discussion-
Domestic Violence
Act2005

> Oral questioning

> Discussion-Geo
thermal energy,
Tidal energy

Key terms

Key questions
NCERT Exercise
Assignment

Y V VY

Key terms

Key questions
NCERT Exercise
Assignment

Y V VYV

Key terms

Key questions
NCERT Exercise
Assignment

Map- Distribution of
Iron, Bauxite,
Manganese and mica
> Flow Chart-
Conventional and

Non-conventional
Resources

VYV VY




Month Project/ Activity Oral Work Written Work
Content/Theme
August > Video > Oralquestioning > Keyterms
4 Our Pasts-IIT = Tribal groups in India > Discussion-Coal > Keyquestions
= Chapter 4 Tribal Dikus & The Vision of a > Activity miners ofBihar > NCERTEXxercise
GoldenAge = Story writing-Tribalheroes > Assignment
1. How did Tribal GroupsLive?
2. How did Colonial Rule Affect TribalLives?
3. A closerlook
= Chapter 5 When People Rebel 1857 andAfter |> Video > Oralquestioning > Keyterms
1. Policies and thePeople = Revolt of1857 > Discussion-Revolt > Keyquestions
g. ;h;;{)ugh thg Eyes of tlfl)ePe(iple el > Activity 1857 > NCERTExercise
. utiny Becomes a Popularrebellion = Quiz- Revolt of1857 .
4. The Company FightsBack ? : f/;slgnment
5. Aftermath P
{ Social and PoliticalLife-III
= Chapter 5 Judiciary > Video > Oral questioning > Key terms
1. What is the Role of the Judiciary? = Judiciary in India > Discussion- > Key questions
2. What is an Independent Judiciary? > Activity Independent > NCERT Exercise
3. What is the Str:ucture of Courts in India? = Story writing- Judiciary. > Assignment
4. What are the different Branches of the ‘JUS.UCC delayed is the justice > Flow chart —
Legal System? denied.” Courts in India
5. Does Everyone Have Access to the Courts?
{ Our Pasts-IIT
= Chapter 6 Colonization and The City > Video > Oralquestioning > Key terms
1. What Happened to Cities UnderColonial - Maklng of New Delhi > Discussion_Making > Key questions
Rule? > Activity of NewDelhi > NCERT Exercise
2. The Making of New Delhi = Comparative study-Old Delhi >  Assignment
3. Inside the Old City and New Delhi > Map




Month
Content/Theme

Project/ Activity

Oral Work

Written Work

September

d Social and Political Life-ITI

HALF YEARLY EXAMINATION

= Chapter 6 Understanding Our Criminal Justice Video > QOral questioning |> Key terms
System = Criminal Justice System > Discussion-FIR > Key questions
1. What is the Role of the Police in Investigating Activity > NCERT Exercise
a Crime? = Role play-Functions of > Assignment
2. What is the Role of the Public Prosecutor? criminal justice system
3. What is the Role of the Judge?
4. What is a Fair Trial?
October Video > Oralquestioning > Keyterms
4 Our Pasts-III = Tata Iron and SteelPlant > Discussion-Tata | > Keyquestions
= Chapter 7 Weavers, Iron Smelters and Activity Iron andSteel. > NCERTEXxercise
Factory Owners = Essay writing -Craftsmen » Assignment
1. Indian Textiles and the WorldMarket Community inIndia - Map
2. The sword of Tipu Sultan and WootzSteel
{ Social and Political Life-III
= Chapter 7 Understanding Marginalization Video > Oral questioning |> Keyterms
1. Who are Adivasis? = Minorities inIndia > Discussion- Low |5 Keyquestions
2. Adivasis andStereotyping Activity literacy rate in » NCERTEXxercise
3. Adivasis andDevelopment = Story completion - Soma minorities . Assignment
4. Minorities andMarginalization andHelen
I Resources andDevelopment
= Chapter 4Agriculture Video > Oralquestioning > Keyterms
1. Farm system = Farming inIndia > Discussion- > Keyquestions
2. Types of Farming Activity Indianfarmers - NCERTExercise
3. Agriculturaldevelopment = Collection of pictures-USA . Assignment
Farmers. Flow Chart-
> Primitive and
Subsistence

Farming




Month Project/ Activity Oral Work Written Work
Content/Theme
November > Video > Oralquestioning > Keyterms
4 Our Pasts-II1 = Macaulay’s education > Discussion- > Keyquestions
= Chapter 8 Civilizing the "Native'" Educating System WoodsDespatch > NCERT
The Nation > Activity Exercise

1. How the British sawEducation
2. What Happened to the LocalSchools?
3. The Agenda for a NationalEducation

= Chapter 9 Women, Caste and Reform.
1. Working towardsChange
2. Caste and Social Reform
3. The Non-Brahman movement

= Chapter 10 The Changing World of Visual Arts

1. New forms of Imperial Art

What happened to the CourtArtists?
The New Popular IndianArt

The search for a National Art

Bl el N

{ Social and Political Life-III
= Chapter 8 Confronting Marginalization
1. Invoking Fundamental Rights
2. Laws for the Marginalized
3. Protecting the Rights of Dalit’s andAdivasis
4. Adivasi Demands and the 1989Act

= Debate- EducationSystem

> Video
= Gender and Caste reforms in
India
> Activity
= Quiz- Caste reforms inIndia

> Video
= History of IndianArt
> Activity
= Collecting Information on
different art forms inIndia.

> Video
= SC & ST Act1989
> Activity
= Tabular presentation on
Socio-economic condition of
Marginalizedcommunity

> Oralquestioning
> Discussion-Caste
discrimination

> Oralquestioning

> Discussion-
Photographyin
India

> Oralquestioning

> Discussion-1989
Act.

> Assignment

> Keyterms
Keyquestions

> NCERT
Exercise

> Assignment

v

> Keyterms
> Keyquestions

> NCERT
Exercise

> Assignment

> Keyterms
> Keyquestions

> NCERT
Exercise

> Assignment




Month Project/ Activity Oral Work Written Work
Content/Theme
November > Video > Oral > Keyterms
{4 Our Pasts-III = History of IndianArt questioning > Keyquestions
= Chapter 10 The Changing World of VisualArts > Activity > Discussion- > NCERT
1. New forms of Imperial Art = (Collecting Information on Photography Exercise
2. What happened to the CourtArtists? different art forms inIndia. inIndia > Assignment
3. The New Popular IndianArt

4.

The search for a NationalArt

December
4 Our Pasts-I11

PERIODIC TEST -2

= Chapter 11 The Making of The NationalMovement > Video > QOral > Keyterms
1. The Emergence ofNationalism = Dandi March Quit India questioning > Keyquestions
2. The Growth of MassNationalism Movement > Discussion- > NCERT
3. The March toDandi > Activity National Exercise
4. Quit India andLater = Essay- Leaders of National Movementsin | > Assignment
Movement India > Map
d Social and PoliticalLife-IIT
= Chapter 9 PublicFacilities > Video > Oral > Keyterms
1. Water and the People of Chennai = Public Facilities inIndia questioning > Keyquestions
2. Water as part of the Fundamental Right toLife > Activity > Discussion- > NCERT
3. PublicFacilities = Report- Public Transport Public Exercise
4. The Government’sRole System inIndia Facilities > Assignment
5. Water Supply to Chennai: Is it Available toAll?
6. In Search ofAlternatives
January > Video > Oral > Keyquestions
{ Our Pasts-I11 = Division of India on questioning > Keyterms
= Chapter 12 India afterIndependence LinguisticPrinciples > NCERT
1. A new and DividedNation Exercise

2.
3.

A Constitution 1sWritten
How were States to be formed?




Month Project/ Activity Oral Work Written Work
Content/Theme
January > Activity > Discussion- > Assignment

4 Our Pasts-IIT
= Chapter 12 India afterIndependence
4. Planning for Development
5. The Nation, Sixty year son

{ Social and PoliticalLife-IIT
= Chapter 10 Law and SocialJustice
1. Bhopal GasTragedy
2. What is a Worker’sWorth
3. Enforcement of SafetyLaws
4. New laws to Protect theEnvironment

J Resources andDevelopment

= Chapter 5 Industries

1. Classification ofIndustries

Factors affecting Location ofIndustries
IndustrialSystem
IndustrialRegions
Distributions of MajorIndustries
Cotton Textile Industry
Information Technology(IT)

Nk WD

= Chapter 6 HumanResources
1. Distribution and Density ofPopulation
2. Factors Affecting Distribution of
Population
3. GeographicalFactors
4. Social, Cultural and EconomicFactors

= Debate- Division of states on
Linguistic groups

> Video
= Bhopal GasTragedy
> Activity
= Report- Bhopal GasTragedy

> Video
= Jamshedpur Iron and Steelplant
= Information Technologyin
India
> Activity
= Report- IT hub ofIndia
(Bengaluru)

> Video
= Population change andfactors
affecting inIndia

English asa
language

> Oral
questioning

> Discussion-
Environmental
degradation

> Oral
questioning

> Discussion-
Industrial

Development in
India

> Oral
questioning

Keyterms
Keyquestions
NCERTExercise
Assignment

VvV VY

Keyterms
Keyquestions
NCERTExercise
Assignment
Map- IT and Iron
and Steelindustry

YV VV VY

> Keyterms
> Keyquestions
> NCERTExercise

FEBRUARY

REVISION FOR ANNUAL EXAMINATION

MARCH

ANNUAL EXAMINATION




ANNUAL CURRICULUM PLAN

CLASS

-Vl

(Session: 2026-27)

Computer Science

Examination Schedule & Syllabus
(Session: 2022-2023)

Computer
Science

Term-1

7 September 2022
4 MS Access
1 Computer Networking
d More on Internet

Term-2

2 March 2023
4 HTML
4 Adobe Flash
4 Computer Ethics, Crime &
Security




Curriculum Plan of Computer Science
(Session: 2026-27)
]

Book Prescribed: Magic With computers

Month Theory Activities Practical /Project
April -
Learn To Use > Introduction > Discussion of data, records, > Create And Set The
IAccess 2007 . .
> Database database of student & Writing Field Of
> Rdbms Student database - 15 records e Student Data
> Database Object > Same way Employee data and e Teachers Data
e Table teacher's data e Employees Data
e Form > Define database and rdbms Manually
e Report > Define database object table form Lab
a
report and query
* Query > Def > Create And Set The
i efine ms access
> Starting Ms Access . Field Of
> Creating A Database (Blank By A Template) > Create database in ms access e  Student Data
> Creating Table (blank) e Teachers Data
> Creating Table Using Design View > Createtables in database using e Employees Datain
> Viewing Table In Database design view data sheet view MS Access
N - > View and describe table structure
> Switching View
> . .
> Primary Key Define primary key
. . > Switch between different views
> Relationship
> Add, update, delete, records in
table
> Create relationship in tables
May Vacation




June
Queries, Forms &

Report In Ms-
Access 2007

Introduction

Queries In Ms Access

e Creating Different Queries
Forms In Ms Access

e Creating A Form

Reports In Ms Access

e Creating A Report

v

Define Form Report And Query
Create Form And Update Record

Create Report And Adjust Field
Size For Printing

Create Query And Run

Lab

Create And Set The

Field Of

e  Student Data

e Teachers Data
Employees Data in
MS Access

And create query,

report and form for the

same in MS ACCESS




Month Theory Activities Practical /Project
July
Introduction > Introduction > Define computer network > Visit To Computer Lab And
To Computer . )
: > Computer Network > List the benefits of a network Understand LAN
Networking
> Creating Computer Network > Create computer network > Make Chart Of Network LAN, MAN,
> Network Benefits > list hardware requirement to WAN, CAN
> Network Hardware establish a computer network
> Types Of Network PAN ,LAN, WAN And MAN > differentiate between various type
> Nature Of Computer Network of network and their nature
> Network Technologies > Define network topologies list
>  Star Topology ,Ring Topology, Bus Topology advantage and disadvantage of
> Protocols various topologies
> Define protocol
August
> Introduction > Define commerce and the mode of > Collect Information About
More On Internet
> E-Commerce e-commerce e EWallet,
e Advantage Of E-Commerce > |dentify the types of people e Blog,
e E-Commerce Payment System involved in e-commerce e Digilocker
e E- Commerce Sites And Ethics > List the advantage of e-commerce
e How To Do Online Shopping > Know e-commerce payment system
> Online News > Define ethics and sides of e-
> Video Conferencing commerce
> Newsgroups > Online shopping
> Blogs > View online news on toi
> Social Networking > Define video conferencing and

newsgroup

> Define blogs and list its advantages

> Social networking sites and its
advantages




September Lab- Practical — Revision of all topics & Practical exam for Term-1
HALF YEARLY EXAMINATION- Written Exam
Month Theory Activities Practical /Project
October _
Introduction to "Introduction of HTML “JUnderstand the tools required to Lab
HTML [IFeatures of HTML

[UTools required to create a web page

[1Terms in HTML

[JStructure of an HTML Document

[JCreating & saving HTML document with
text editor

[0Viewing an HML document in web browser

create web page
e Text editor
e A Web Browser
e A web Server

[1Terms in HTML
[ITHTML Tag-
e Empty- nonempty
e Attributes
e Values
e Nesting tags

e Special symbols
OStructure of HTML
[IBasic syntax of HTML
[JCreating HTML document in
text editor- Notepad
[JSaving it as name.html
[JViewing the same in web
browser

> Create first web page in notepad
and save as first.html

>  View in browser

November
Creating
Webpage
using HTML

> Introduction
> Adding headers
> Adding paragraphs
> Adding line breaks
> Drawing horizontal line
e adding color , width to lines
> Formatting text

> Create web page using HTML

> Add header, paragraph, line breaks

> Draw horizontal rules & add color
to the lines

> change font, font size, font color
and font style

Lab
> Create an HTML document
e set background
e Header
o Title

> 1nsert horizontal line and add color
Lab




> Marquee text

> Adding comments

> Setting background color

> Inserting images

> Setting image as a background
> Creating lists

> Creating Tables

> Inserting pictures, images

> Inserting Hyperlink

> Add Marque effect
> Add comment in HTML document
> Insert images
> Change the background
> Create tables
> Create Lists
e ordered list
e unordered list
e nested list
e Definition list
> Insert hyperlinks

> Create a HTML document

e Insert image

e Write text and insert marquee

e Make the list of shakes in
ordered list

e Make list of snacks in
Unordered list

e insert hyperlink of related
document

o Insert table with price list

December
Learn to use
Adobe
FlashCS3

introduction

Starting Adobe Flash CS3\
Creating new flash file
Components of the Flash Interface
Saving Flash file

Opening a Flash File
Exiting Flash

Flash Tools Panel

Using the Flash Tools
Line

Pencil

Rectangle tool

Brush tool

Paint Bucket tool
Eraser

Text

Selection tool

e Free Transform

VVVYVYYVYYYVY VY

> Property inspector
> Grouping Objects
> Timeline Panel

e Frames

> start Adobe Flash CS3

> Create a Flash file

> Identify and name the components
of Flash interface

> Save, Open and exit Flash file

> View the components of Tools
panel

> Know the use of property Inspector

> Use Various tools

Line

Pencil

Rectangle tool

Brush tool

Paint Bucket tool

Eraser

Text

Selection tool

Free Transform

> Group and ungroup objects

> ldentify different components of

timeline panel
> Insert key frames/ frames

Lab

> Draw the image in Flash and group
all the object as one.

> Open a Flash document and create
the symbol and make many
instances of it

Lab

> draw the ball with oval tool and

give effect to see bouncing ball

> Draw Caterpillar with oval shape

and make it move with animation
motion tween

> Make a fish and move it from left

to right on the stage using motion
tween animation

> Draw a circle and change to flower

using shape tween animation

> Show frame by frame animation to

make the text "Hello" appear
character by character.




e Layers > Delete frames
> Symbols > Define layer
> Animating movie > Create symbol
e Motion Tween animation > Animate & test flash movie
e Shape Tween animation e Motion Tween animation
e Frame by Frame animation e Shape Tween animation
e Frame by Frame animation
January Make the chart of Cyber security
Computer > Introduction > Define computer Ethics guidelines
Ethics, Crime |~ Computer ethics . > List major ethical issues in Make a chart of computer crime
and Security o Intelleptual Property rights comput d how d
o Copyright puter and how to avoi
o Software Piracy > Define Software piracy and its
e Privacy types
> Computer Crime > Define and differentiate Hacker &
i Hacki.ng Cracker
s cracking > List the various computer security

> Computer Security
> Last words

issues

February

Lab Practice For HTML and Practical Annual Examination

Project - HTML -Create web pages of any three important organ of body with images

March

ANNUAL EXAMINATION- Written
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STD 8

April

June

July

August




September

C

October

November

Decemver

(Activity)

January




February




